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In Silico Investigation of Phytochemicals Derived
from Catharanthus roseus as Potential Therapeutic
Agents Targeting the A42R Protein of the Human
Monkeypox Virus.

ESHITA

ABSTRACT

The Human Monkeypox virus (MPXV) causes an animal-borne
disease and belongs to the Orthopoxvirus genus. In 2022, the
largest outbreak of this disease led to an epidemic in various
countries. As stated by the World Health Organisation (WHO),
physical contact with affected animals, persons, or contaminated
surfaces may serve as possible transmission routes for the virus
infection. Symptoms may appear after an incubation period of
about 7-14 days, including myalgia, fever, fatigue, body aches,

headaches, skin lesions, and lymphadenopathy.

JYNNEOS and ACAM2000 are both FDA-approved vaccines used to
prevent Monkeypox disease however, the latter vaccine can cause
severe conditions like pericarditis and myocarditis in
immunocompromised vaccinated individuals. Thus, drugs that can
target the virus are in high demand, according to current
circumstances. Therefore, Catharanthus roseus, a medical plant
with active phytochemical compounds, can serve as a potential
source for synthesizing herbal drugs. In this research, using
molecular docking, the leading active compounds observed in the
plant showed remarkable interactions with suitable binding
affinities. Barassinolide surpasses other phytochemicals regarding
binding energy, i.e., -8.7 kcal/mol, making it the most promising

phytochemical that can be used as a therapeutic target.
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CHAPTER 1

INTRODUCTION

The Monkeypox virus was first reported in Africa and belongs to the
orthopoxvirus genus of the Poxviridae family. The ‘monkeypox’
name came after it was found in macaque monkeys. However, the
origin of the virus is unknown to date, but it is estimated that it is
transmitted via various small mammals and rodents. Humanity's
history has seen various viral epidemics lead to major effects on the
health of the world population, as well as on society. HIV-1 (Human
Immunodeficiency Virus-1), smallpox, Ebola, influenza, SARS-
CoV-2 (severe acute respiratory syndrome coronavirus-2), and
SARS (severe acute respiratory syndrome) have all demonstrated the
devastating consequences of viral outbreaks, highlighting the urgent
need for effective surveillance, treatment, and prevention strategies
[1]. Human Monkeypox Virus was initially recorded in 1958, when
a vesicular disease occurred among monkeys mobilized from Africa
to Denmark and Copenhagen for study. in 1970, on August first
human case of hMXPV was recorded in a 9-year-old child having
skin lesion symptoms similar to smallpox, in Bukenda village is
located in the equatorial region of the Democratic Republic of Congo
(DRC) [2].

The World Health Organization (WHO) Director-General, on 23™
July, amid the 2022 outbreak of the Human Monkeypox Virus, with
the majority of cases in Europe, declared it a Public Health
Emergency of International Concern (PHEIC) [3]. The 2022
outbreak affected 118 countries, having confirmed cases or
suspected cases. Overall, 64851 verified and 3673 presumed cases
were documented as of 2022-09-23. Out of 64851 confirmed cases,
248 cases had a travel history [4]. Under the present circumstances,

there are 3 FDA-authorized vaccines to treat smallpox and
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monkeypox diseases. As of now, we do not have any antiviral
medications specifically for the monkeypox infection treatment.
Although some medications for smallpox treatment, such as
cidofovir, tecovirimat, and Brincidofovir, can be used for the
monkeypox infection treatment [1]. Therefore, it is crucial to explore
potential drug targets. Historically, herbal medicines were widely
used to treat various infections and diseases because of their
abundant therapeutic bioactive substances, which laid the foundation
for the development of plant-based drug formulations. Plant-based
medications have shown great results against several viruses, such
as influenza viruses, coronaviruses, and poxviruses. This opens the
door for exploring antiviral plant-based medications for the Human
Monkeypox Virus. Researchers have worked on several alkaloids,
triterpenes, flavonoids, and phenolic compounds metabolites known
for their antiviral properties. Recent studies showed that curcumin
derivatives are powerful antiviral agents effective against smallpox
and monkeypox viruses [5]. Utilizing computational methods like
molecular docking, researchers can efficiently screen large libraries
of chemical compounds to identify phytochemicals with potential

therapeutic effects.

This dissertation explores the potential phytochemicals for the cure
of the Monkeypox virus by utilizing in silico methods. We will focus
our study on finding the phytochemicals that can inhibit the A24R
protein of the Human Monkeypox Virus. Additionally, we
investigate the ability of various compounds extracted from
Catharanthus roseus to inhibit the same protein. Using molecular
docking simulations, we examine the binding affinity and potential
effects of these compounds, thereby enhancing our understanding in

the development of novel therapeutic strategies.
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1.2 Importance of Targeting the A42R Protein

The A42R protein (PDB-4QOW) encoded by the gp153 gene in
hMXPYV is significantly similar in terms of amino acid sequence to
the profilin protein of eukaryotic cells [6]. The structure A42R
protein is reported to be the 1st and only hMPXV protein
documented in the Protein Data Bank (PDB). In 1990, studies were
conducted to determine its biochemical significance. Further studies
showed the significance of the protein in viral replication in the
host’s cells [7].

The A42R protein, found in orthopoxviruses, is known to share
structural similarity with host actin-binding proteins, thus suggesting
its role in manipulating the cellular machinery of the hosts to benefit
viral replication and spread [8]. However, A42R interacts weakly
with actin where whereas other cellular profilin proteins interact
strongly [9]. Actin is mainly related to the disease-causing ability of
different poxviruses by influencing the viral transmission to the
surrounding host cells.

In the studies of other homologous profilin proteins present in
various poxviruses, it is reported that alpha-tropomyosin (a cellular
38kDa actin-binding protein) interacts directly with the profilin-like
protein of the virus and colocalizes with surface tubules, suggesting
the involvement of tropomyosin in virus mobility [10]. A42R,
interaction with phosphatidylinositol lipids, this interaction suggests
that it uses the mechanism that manipulates the host cell and wraps
the virus, required to fuse it with the plasma membrane, and also
protects it in the cytoplasm [9] [11]. Given its critical role in
cytoskeletal modulation and its uniqueness to the viral proteome,
A42R presents a promising and selective target for antiviral therapy.
Despite its importance, A42R remains largely unexplored in terms
of drug targeting, presenting an opportunity for the discovery of first-
in-class inhibitors. This highlights the A42R protein as a valuable
target for developing new antiviral treatments against the

monkeypox virus. By focusing on this protein, researchers may be
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able to interfere with important stages of the virus's life cycle,
potentially stopping it from spreading inside the body. Targeting
A42R could also help create therapies that are more specific to the
virus, reducing the chances of harming healthy human cells and

improving treatment safety.

1.3 Phytochemicals as a Therapeutic Approach

Phytochemicals are bioactive compounds derived from plants that
have become a cornerstone in modern drug discovery, contributing
significantly to the pharmaceutical market. Compared to randomly
synthesized molecules, drugs obtained from natural sources often
demonstrate better biocompatibility, improved safety profiles, and
fewer side effects. The treatment via plant-derived compounds is
known as phytotherapy, provides a promising and holistic approach.
The phytochemicals perform diverse biological roles, which include
disrupting cell membranes, inhibiting key proteins, or interacting
directly with nucleic acids such as RNA or DNA. Unlike synthetic
drugs, the effectiveness of phytochemicals often results from
synergistic interactions, where multiple compounds enhance each
other's effects or act on different points of the same biological
pathway.

Mechanisms underlying these interactions may involve improved
bioavailability, altered transport within cells, transformation of
prodrugs into active forms, or neutralization of harmful metabolites.
In addition, many phytochemicals can modulate entire signalling
cascades through multi-target activity, offering broader therapeutic
coverage [12].

As the viral disease epidemics are threatening the entire world, the
2022 monkeypox outbreak and the 2020 coronavirus outbreak are
recent examples that highlight the urgent need to develop effective
antiviral drugs against different kinds of viruses. Although some
antiviral drugs are on the market at present for the treatment of some

viral diseases, for some, there are no antiviral medicines or vaccines
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present in the market. Synthetically developed drugs are directly or
indirectly related to harmful side effects.

Due to this, the demand for antiviral drugs formulated via plant
compounds is on the rise, as their toxicity is low and they have a low
possibility of developing resistance. Phytochemicals have been in
use for a long period, used to cure several illnesses, and studies show
that they are a great candidate for a drug as they exhibit anti-viral,
antibacterial, anti-cancerous, and antioxidant properties. Most of
these compounds act by interfering with viral processes, either by
blocking the virus's entry into the host cell or by disrupting its
replication cycle [13]. Around 2,500 plant species with medicinal
properties have been identified worldwide and are traditionally used
to manage a vast range of medical conditions in humans and other
animals. The bioactive phytochemicals found in this plant have
shown promising antiviral properties, making them valuable
candidates in the fight against various viral infections, such as
alkaloids, quinone, flavonoids etc [14]. Despite the vast therapeutic
promise of phytochemicals, their application still faces several
challenges, such as standardization, bioavailability, efficacy, and
safety in clinical use. However, recent progress in computational
methods like molecular docking has greatly improved the ability to
screen and identify effective phytochemicals, thereby speeding up

the drug discovery in this area.

1.4 In Silico Approach in Drug Design

In silico techniques are becoming gradually vital in modern drug
discovery, offering a cost-effective approach to identifying potential
therapeutic candidates. These computational strategies help reduce
reliance on animal testing, support the rational development of new
and safer drugs, and enable the repurposing of existing
pharmaceuticals. By streamlining various stages of the drug
discovery process, CADD tools provide valuable insights for

medicinal chemists and pharmacologists, enhancing efficiency and
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precision in the search for effective treatments [15]. Ligand-protein
docking is a potent software tools for estimating the binding
affinities of selected ligands and with chosen proteins, with
exceptionally precise and effective. This approach is essential in the
drug discovery and design process, as it helps identify promising
lead compounds that can bind selectively to targeted proteins,
thereby influencing their biological function [16].

At its foundation, ligand-receptor binding simulation is a computer
based technique that is used study how different ligands interact with
proteins binding site in three-dimensional space. Using specialized
algorithms that consider factors like the ligand's flexibility, possible
structural changes in the protein, and electrostatic compatibility,
docking tools can estimate the most stable and energetically
favourable way a ligand fits into the protein’s binding pocket [17].
The precision and dependability of molecular docking results are
influenced by multiple factors, such as the resolution and quality of
the target protein structure, the selection of an appropriate scoring
function, and the consideration of solvent interactions and protein
flexibility [18]. Furthermore, comparing docking outcomes with
experimental evidence like crystal structures or measured binding
affinities is crucial for evaluating the accuracy and effectiveness of
docking algorithms. Due to its computational nature, molecular
docking has become a potent tool in virtual screening efforts,
enabling the efficient identification of promising and effective drug
candidates from extensive chemical libraries. Researchers can select
and prioritize potential leads by screening thousands of compounds

in silico.

1.5 Study Objective and Scope

This research primarily seeks to employ molecular docking

strategies to identify potential bioactive phytochemicals present in

Catharanthus roseus, targeting the desired protein found in Human
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Monkeypox Virus leads to inhibition of the virus. Specifically, the

research aims to:

1. Select a protein which is widely known for its essential role
in infection mechanism, based on a comprehensive review of

the literature and expert consultation.

2. Build a database of phytochemicals with potential ligand
activity by sourcing compounds from various chemical

libraries and bioactivity databases.

3. Perform molecular docking simulations to evaluate
interactions between the target protein and selected plant
compounds acting as ligands, taking into account ligand

flexibility and potential structural alterations in the receptor.

4. Assess the precision and predictive strength of the docking
results by comparing them with available experimental data,
where applicable, to ensure the reliability of the
computational method.

5. Examine the highest-ranking docking poses and scoring
parameters to select the most promising leading compounds
for further research, taking into account factors such as
binding affinity, target specificity, and drug-like properties.

6. Evaluate the contribution of the findings for designing novel
treatments by targeting the A42R protein found in the human
monkeypox virus, emphasizing their potential to contribute
to effective antiviral drug development using plant-derived

compounds.
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The scope of this research involves computational and theoretical
investigations to explore the molecular mechanisms through which
plant-derived phytochemicals may inhibit the A42R protein found in
monkeypox virus. While the study is centred around molecular
docking as a predictive approach, it also incorporates concepts from
structural biology, pharmacology, and bioinformatics to develop an
in-depth understanding of the interactions between chosen
phytochemicals and the targeted viral protein. This integrative
strategy aims to support the identification of novel antiviral

candidates capable of disrupting viral function at the molecular level.
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CHAPTER 2

Literature Review

The Human Monkeypox virus, a concerning viral animal borne
disease in humans, this virus is related to Orthopoxvirus genus in the
Poxviridae family [19]. It is a dSDNA virus, has a 200kb long DNA
sequence containing highly conserved genes encoding for
replication machinery and viral assembly complex in the middle of
the genome, and various genes related to its virulence and host
determination in the terminal ends. Based on the morphology of
MPXV, which resembles that of other orthopoxviruses (OPXVs),
the virions appear as ovoid or brick-shaped structures surrounded by
a lipid-protein which is the outer membrane. The MPXV genome
encodes all the proteins necessary for viral DNA replication,
transcription, and the assembly of new virions, and their release from
the cell [20]. The MPXV may be classified mainly into 2 genetic
groups, i.e., the Clade I-Congo basin and Clade Il-west African
group. Former exhibits higher death rates in comparison to the latter,
due to some deletions and fragments in open reading frames (ORF),
which can be the reason for the low virulence of the West African
group [2][21]. Research shows that the Central African monkeypox
virus interferes with triggering T-cells and also suppresses cytokine
release, which causes inflammation in infected host cells. Moreover,
this strain appears to specifically impair the host's immune response
by suppressing apoptosis and blocking the transcription of certain
immune-related genes [22].

Human monkeypox typically presents with symptoms observed
mainly in children and adults from Central and West Africa. The
illness starts with a viral prodrome lasting 1-3 days, marked by
fever, chills, headache, body aches, muscle aches, and back pain.

Subsequently, a maculopapular rash develops, which is usually
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monomorphic and spreads in a centrifugal pattern. The rash evolves
through vesicular and pustular stages before forming crusts
throughout 2 to 3 weeks. Marked lymphadenopathy is a
distinguishing feature of monkeypox [23].

The transmission routes of the Human Monkeypox Virus can be
divided into zoonotic transmission (1°transmission) and interhuman
transmission (2°transmission). This involves injuries from infected
animals, eating poorly cooked infected meat, exposure to infected
blood or bodily fluids, and direct contact with cutaneous/ mucosal
lesions, sexual contact with infected humans, respiratory droplets,
and contact with contaminated surfaces/objects. A few studies show
that pregnancy during the infection can lead to vertical transmission
and perinatal loss [24][25].

Monkeypox is a reappearing viral threat, a global health issue
because of its interhuman transmission and the absence of defined
antiviral treatments. Its symptoms can range from fever and rash to
severe systemic complications, particularly in immunocompromised
individuals. This study aims to contribute to the search for effective
therapeutic strategies by targeting the A42R protein found in the
monkeypox virus using plant-derived phytochemicals. The docking
simulation serves as a key computational approach to evaluate the
binding potential of these compounds. By simulating protein-ligand
interactions, this method helps identify promising lead molecules
with inhibitory activity against A42R, supporting the development

of novel plant-based antivirals.

2.2 Exploring Molecular Targets for Antiviral Drug

Development in Orthopoxviruses

The World Health Organization (WHQO) have currently classified
human monkeypox virus (hMPXV), an animal-borne infection, as a
global Health Emergency and states that at present, we lack specific
treatments potential for Mpox infection. Medicinal herbs play a

crucial part in both the medical field and economical development,
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especially in developing countries.

The main structural proteins, like A29,L1R, and,H3L, exhibit
critical roles in the virulence of the monkeypox virus and play a vital
role in both viral invasion and host immune activation. Proteins like
A35R, B6R, and A42R responsible for viral growth in host cells, can
be identified as potential vaccine targets. MPXV employs several
immune evasion strategies, including hiding its DNA,
downregulating interferon production, inhibiting T and natural killer
cells stimulation, also blocking regulated cell death. These
mechanisms present significant challenges in the development of
effective vaccines and treatments [26].

Orthopoxvirus replication involves a complex series of steps, each
presenting potential molecular targets for antiviral intervention. Key
targets include structural and entry proteins such as A27L, H3L, and
B5R that facilitate viral attachment and fusion, as well as
transcriptional regulators like Rap94 and A8L, which initiate early
gene expression. DNA replication is primarily driven by the E9L
DNA polymerase and associated proteins, making them effective
targets for nucleoside analogs such as cidofovir and CMXO00L1.
Additional enzymes like viral thymidine kinase (J2R),
ribonucleotide reductase, and protein kinases (B1R, F10L) also
regulate viral replication and interfere with host immunity. Later
stages involving genome packaging, virion assembly, and egress rely
on proteins like 17L, D13L, F13L, and A36R, several of which are
inhibited by drugs like ST-246 (Tecovirimat) and mitoxantrone.
Together, these components of the viral life cycle offer multiple
strategic points for therapeutic targeting [27].

Unlike bacterial and fungal infections, viruses rely on living host
cells for replication, which makes their control particularly
challenging. They integrate into host cells at both functional and
structural levels, making it difficult to distinguish and eliminate
them. Additionally, certain viruses can remain dormant as latent
infections, posing long-term health concerns. The limited

availability of effective antiviral treatments, coupled with the risks
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of drug toxicity and the emergence of cross-resistant viral strains,
further complicates management. Consequently, increasing attention
is being directed toward plant extracts and phytochemicals as
promising alternative strategies for combating infectious diseases in
livestock, with ongoing research exploring their antiviral potential
[28].

2.3 Phytochemicals of Catharanthus roseus and Their Antiviral

Potential

Originally indigenous to Madagascar, Catharanthus roseus,
typically referred to as the Madagascar periwinkle, is a well-known
therapeutic plant recognized for its extensive pharmacological
properties, related to Apocynaceae family. Studies suggest that the
bioactive compounds found in this plant demonstrate higher
antibacterial, antiviral, antifungal, and anticancer properties. Several
phytochemicals, such as vindolinine, periformyline, leurocristine,
perivine, perividine, vincaleukoblastine, pericalline, carosine, and
leurosivine have demonstrated antiviral activity against both
vaccinia virus, poliovirus type 111, and dengue virus type 2. [29][30].
Further, C. roseus extract demonstrated wide-ranging antibacterial
activity against Salmonella typhi, Pseudomonas aeruginosa,
Staphylococus aureus, and shigella boydii. It also exhibits antifungal
activity against Ganoderma philippii, Rigidoporus microporus,
and Phellinus noxius [31]. Vincristine and vinblastine, originally
extracted from Catharanthus roseus, were notably the first plant-
based anticancer compounds introduced into clinical practice. More
recently, several newly extracted indole alkaloids present in this
plant, such  as 14',15'-didehydrocyclovinblastine, 17-
deacetoxyvinamidine, catharoseumine, and 17-
deacetoxycyclovinblastine have shown potent inhibitory effects on
cultured human cells. In addition, phytochemicals like vindolicine,

vindolinine, vindolidine, and vindoline, extracted from the C.
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roseus, have demonstrated promising antidiabetic properties.
Mentioned findings demonstrate that this flora remains a valuable
reservoir of bioactive compounds and warrants further scientific
exploration [32]. Catharanthus roseus is also useful in the treatment
of hypertension and diabetes mellitus. This plant also exhibits anti-
inflammatory, antimicrobial, antithrombotic, antioxidant, anti-
allergic, and vasodilatory effects and cardio-protective properties
[33].

The broad spectrum of bioactive compounds found in Catharanthus
roseus, including several indole alkaloids with known antiviral,
anticancer, and antidiabetic properties, reinforces its importance as
a valuable resource in modern drug development. Given the urgent
need for effective antiviral therapies against emerging infections
such as monkeypox, the exploration of C. roseus-derived
phytochemicals offers a promising strategy. In this study, these
compounds were analysed via in molecular interaction modelling to
assess their binding potential against the A42R protein found in
monkeypox virus, a structurally unique and functionally important
viral target. The integration of traditional medicinal knowledge with
computational tools not only supports the relevance of C. roseus in
antiviral research but also lays the groundwork for the development

of plant-based therapeutics against Orthopoxvirus infections.

2.4 Structural and Functional Insights into the A42R Protein

and Related Orthopoxvirus Targets.

Structurally, A42R protein (PDB-4QOW) is similar to host actin-
binding protein in terms of amino acid sequence it is composed of
157 amino acid residues, that is encoded by the gene gpl53 in
monkeypox virus. The protein structure was resolved using X-ray
diffraction at a high resolution of 1.52 A, revealing a compact
globular folds, typical of profilin family proteins. The structure
includes two chains (A and B) [34][6].

The aim to consider A42R protein as the target protein of
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monkeypox virus is because this is the first and only monkeypox
virus protein documented in the protein data bank, i.e., PDB [7].
Various studies have been carried out till now to study its purpose
and roles in the spread. Some studies suggest that it plays a role in
viral replication in host cells via manipulating the host cellular
machinery, contributing to viral replication and viral spread [8].
Hence, by adopting a similar structure, A42R may interfere with host
cytoskeletal dynamics and intracellular transport, aiding viral
replication and spread. Its expression during infection and
conservation across Orthopoxviruses suggests an essential role in
viral pathogenesis, potentially contributing to immune evasion or
host-cell manipulation.

Former studies on Orthopoxvirus proteins have mainly focused on
well-defined targets, namely DNA polymerase (E9L), F13L,
contributing to virion egress, or surface glycoproteins like H3L, and
B5R. However, research on A42R remains limited; despite this,
structural analyses confirm its similarity to eukaryotic profilins, and
recent investigations propose its involvement in viral modulation of
host cytoskeletal machinery. Having a viral origin and functional
importance, A42R remained an unexplored target for antiviral drug
discovery, mainly through in silico screening of natural compounds
[27]. So, in this dissertation, we will target the A42R protein found
in monkeypox virus with the phytochemicals of Catharanthus

roseus.

2.5 Computational Drug Design Techniques.

Molecular docking is a frequently used computational technique for
drug development by analyzing binding interactions between
ligands, such as bioactive compounds, and targeted proteins. With
applications spanning lead identification, optimization, virtual
screening, and structure-based drug design [17]. This approach
simulates the geometric fit and non-covalent interactions between a

ligand and its target receptor within the binding site, allowing for the
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analysis of the most stable binding conformation and its
corresponding binding affinity.

Various molecular docking algorithms have been developed, having
their features and strengths. AutoDock, AutoDock Vina or DOCK
are widely used, employ various functions and algorithms to
navigate the ligand conformational space and enhance their binding
interactions with the target protein. These tools are incorporated with
various criteria such as ligand-protein flexibility and solvent effects,
increasing the dependability and predictive accuracy of docking
simulations [17].

In this dissertation, molecular docking is employed as a core
computational strategy to identify the potent phytochemical
inhibitors of the A42R-targeted protein found in monkeypox virus.
By simulating the interaction between selected plant-derived
compounds from Catharanthus roseus and the viral protein's active
site, the study aims to predict binding affinities and explore the
structural compatibility of these ligands. This strategy enables the
identification of potential bioactive compounds based on their
binding strength, and orientation with the reactive site of selected
proteins from the virus. By combining the principles of structural
biology and pharmacoinformatic, this approach supports the early
phase screening process, making it cost effective and time-efficient
procedure to prioritize candidate molecules for further research. This
in silico framework lays a foundational step toward the development

of novel, plant-based antiviral therapies against monkeypox.
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CHAPTER 3

METHEDOLOGY

The employed methodology in this research is the integration of
computational techniques with molecular docking stimulation to
find the potent bioactive compound present in Catharanthus roesue,
inhibiting target protein A42R of monkeypox virus.

In this dissertation, for virtual screening of various ligands (bioactive
compounds) interacting with the targeted protein, we employed
PyRx.

Below, the given details explain the methods utilized for protein

preparation, ligand selection, molecular docking, and validation

procedures.
1. Downloading the protein
. Utilize Protein Database Bank, i.e., PDB to download the

selected protein, in our case, it is protein A42R.
. Download the protein in the PDB format.

o Store the downloaded protein in a new separate folder

2. Download the ligands

o Use either PubChem or IMPPAT. The former is the database
of chemical substances and their properties, while the latter
is the database of Indian medicinal plants and their natural
compounds.

o Search for the ‘Brassinolide’ as a compound. Download the
corresponding 3D conformer in SDF format. Store it in a new
separate folder.

o Download the Teasterone, Typhasterol, Quercetin,
Kaempferol, 2,2,6-trimethyl cyclohexanone, and Myristic

acid in the same format mentioned in the immediate above
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step and save all ligands in the same folder.

Preparing the protein

First of all, for protein docking, we should know about the
binding residues and binding location. They may exist in 2
chains of targeted protein or may reside in just one of the
chains of protein. Study the targeted protein structure
through the research papers published related to the protein
structure.

Now, the catalytic binding site of the A42R protein is known.
Protein preparation, it was loaded in Biovia Discovery Studio
for the removal of non-essential components that may hinder
the binding of the specific bioactive compounds with the
selected protein, such components are water molecules,
heteroatoms, and ligands. For better interaction results
addition of polar hydrogens to the protein is suggested. This
led to the stabilization of ligand-protein and electrostatic
interactions, improving the efficiency and precision of the
molecular docking results.

We must remove the extra chains from the targeted protein
structure to prevent any complexity

In this study, we kept chain A and removed the other chain
i.e. chain B, as protein A42R consists 2 chains only, having
chain A and B.

After the preparation of the protein store the file as

Now we have the prepared targeted protein, we can proceed

further for docking.
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Figure 3.3- Protein after modification

4. Performing docking using PyRx.

. We will be using Autodock Vina as docking tool. Using Vina
algorithm to dock it in PyRx. Open the PyRx graphical
interface and proceed with the following steps:

4.1  Protein Loading

. Click on "File" and select "Load Molecule,” or alternatively,
click the first icon in the top-left corner. Then, upload the
downloaded protein structure file, referred to here as
"4QWO.pdb."

o To convert the protein file from PDB to PDBQT format,
right-click on "4QWO," go to "Display,” and select

"Macromolecule."
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4.2 Ligand loading
. In PyRX, click on OpenBabel and choose "Insert New Item"
located at the bottom right corner. Then, upload each ligand

individually by selecting them one by one from the folder.
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Figure 3.6- Loading of ligands

. Once all ligands are uploaded, right-click on a ligand and

choose "Minimize All" to optimize their energy states.
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o Next, right-click again and select "Convert All to AutoDock
Ligand (pdbqt)" to convert all ligands into the pdbqt format.
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Defining ligands and protein.

Under the "Molecules™ tab, both the loaded protein and
ligands are displayed. To distinguish them, right-click on the
protein, go to "Autodock,” and select "Make
Macromolecule.” Similarly, right-click on each ligand,
choose "Autodock,” and then "Make Ligand.” This process
will automatically generate their PDBQT files, which will

appear under the "Autodock” tab.
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Figure 3.10- Undefine grid box

Defining grid box

Now, click on "Vina Wizard" and select the "Start" option
located at the bottom right corner. Using the Shift and
Control keys, select the protein and ligand one by one.
Click "Forward" to proceed, and a grid box will appear.
Then, go to the "Molecules” tab on the right side and click
the "+" icon next to the loaded protein.

All residues within the chain will now be visible. To identify
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the binding residues, right-click on a residue and select
Atoms — Display — Label — Atoms. This will display the
atoms on the protein structure. Next, adjust the grid box to
ensure it encompasses all the selected binding residues. It is

not necessary to include the ligand within the grid box
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Figure 3.11- Defining of grid box

Running Vina for docking

To set the exhaustiveness level, enter the desired value in the
box at the bottom-left corner.

Once all parameters are set, click the "Forward" button to
begin the docking process. The progress will be displayed
on-screen, and upon completion, the bottom panel will show
all generated poses along with their binding affinities and
RMSD values.

Export the results to an Excel file for further analysis.

Next, review the docking results and identify the ligand with
the most negative binding energy, indicating the strongest

binding.
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. Then, go back to the PyRx tab, click on AutoDock, select
Macromolecule, and choose the top-performing ligand.
Right-click on it, select Display, and all models of the ligand
will appear.

o Choose your preferred model and save it in PDB format for

further analysis.
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8. Open Discovery Studio

. Now, start a fresh project in Biovia Discovery Studio

9. Protein Structure Import:

J Open Discovery Studio and import the structure of the target
protein.

J Choose your protein structure file (such as *.pdb) by using
File > Open.
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Figure 3.14- Visualization of protein structure in Discovery
Studio

10. Import Docked Ligand Conformations
o Import the confirmation of docked ligand in Discovery
Studio.

o Click file and select the converted ligand file, i.e., pdb.
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Figure 3.15- Structure of Brassinolide

11.  Visualize Docked poses:

. Protein and ligand to be displayed in the 3D workspace.

. Click the View > sequence panel to make sure that the correct
structures are loaded.

. Modify the display settings for better visualization of the
interactions, using representations like stick or surface view
to highlight the binding between the phytochemicals and the

selected protein.

12.  Analyse Binding Affinities:

o Review the binding affinity values for each docked pose.

o These values can be obtained from the PyRx log files or the
docking output summary.

o Document the binding energies (typically expressed in

kcal/mol) for reference and comparison.
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Investigate Binding Interactions:

Utilize the Analyze > Receptor-Ligand Interactions tool to
explore key interactions between the ligand-protein.
Analyse different bonds

Cross-check the interacting residues for consistency with
known active site features or functionally important regions

of the binding pocket.

Assess Docked Poses:

Evaluate multiple docked conformations to determine if a
consistent binding mode is present.

Use the View > Compare feature to overlay poses and
visually assess structural similarities.

Consider the RMSD values to quantify the variation among
complex conformation and support the selection of the most

reliable conformation.
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CHAPTER 4

RESULTS

The results of molecular docking simulations show the most potent
drug candidates to the cure of the monkeypox virus. By virtual
screening of various bioactive compounds from Catharanthus
roseus against protein A42R, some of the compounds showed
favourable binding affinities and potent therapeutic effects. The
phytochemical exhibiting the highest binding affinity is selected for
further analysis, and its interaction with the target protein is
visualized using Discovery Studio. Additionally, the binding affinity
of cidofovir a compound already used in the treatment of monkeypox
infection is evaluated against the target protein A42R for

comparative assessment.

The images below show the docking results of various bioactive

compounds with the A42R protein.
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Figure 4.4

By analysing the molecular docking results, we can conclude that
Brassinolide exhibits the highest binding score OF -8.7 Kcal/mol ith
energy E=718.52.

. Structure of the studied natural bioactive

compounds present in Catharanthus roseus.

Figure 4.5- Brassinolide
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Figure 4.7- Typhasterol

Figure 4.8- Quercetin
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Figure 4.11- Myristic acid
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The Following Images Show 2-D Structural
Interactions Between Protein-Ligand (4QWO)

Docking of Brassinolide with A42R protein

Interaction diagram showing the binding of Brassinolide
with the target protein.

E score =718.52, binding affinity -8.7 kcal/mol, and rmsd

value=0

2

BAran SEIL
R

Figure 4.12

Docking of Teasterone with the A42R protein
Interaction diagram showing the binding of Teasterone with
the target protein.

E score =610.52, binding affinity -8.6kcal/mol, and rmsd

value=0
ARG
A:3s TS
A5
GLU SER
18 A2
=
: PRO
Q33 A:36
e HIS
An5 = AS

Figure 4.13
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Docking of Typhasterol with the A42R protein
Interaction diagram showing the binding of Typhasterol
with the target protein.

E score =614.50, binding affinity -8.6 kcal/mol, and rmsd

value=0

Figure 4.14

Docking of Quercetin with the A42R protein

Interaction diagram showing the binding of Quercetin with
the target protein.

E score =380.43 binding affinity -8kcal/mol and rmsd

value=0

ILE
A:3S5

SER
PRO Al

Figure 4.15
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Docking of Kaempferol with the A42R protein
Interaction diagram showing the binding of Kaempferol with
the target protein.

binding affinity -7.9 kcal/mol and rmsd value=0

AS s
A5
ILE RO SER
A3S5 A6 A2
ARG
AlB
Gl
A9
/ \\
1
Figure 4.16

Docking of 2,2,6-trimethyl cyclohexanone with the A42R
protein

Interaction diagram showing the binding of 2,2,6-trimethyl
cyclohexanone with the target protein.

binding affinity -5.5 kcal/mol and rmsd value=0

SER
Ai92 Ao
GLU
A:18
ASP
A:19
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A:65
TYR
A:88
PRO
A:90
THR
A:39

Figure 4.17
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> Docking of Myristic acid with the A42R protein
J Interaction diagram showing the binding of Myristic acid
with the target protein.

J binding affinity —5.4 kcal/mol and rmsd value=0

ILE

A3S5 PRO
A6
o
LYS % SER
A:109 = A:12
ILE
AsSN L8
A:l4 ASN
= A:1S GLU
4 A9 HIS
AlS
ILE
All
Figure 4.18

From the above results, we can predict that Brassinolide is the most
favorable candidate among all other bioactive compounds used in the
study, showing the efficiency to inhibit the protein A42R found in
monkeypox virus, as it has the highest binding affinity of -8.7 kcal/mol

highest among all.

BIOACTIVE BINDING AFFINITY
COMPOUND (Kcal/mol)
Brassinolide (A) -8.7
Teasterone (B) -8.6
Typhasterol (C) -8.6
Quercetin (E) -8.0
Kaempferol (F) -7.9
2,2,6-trimethyl -5.5
cyclohexanone (M)

Myristic acid (N) -5.4

Table 4.1 - Phytochemicals and Their Corresponding Calculated Binding
Affinities.
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DISCUSSION

In this dissertation, we used the molecular docking simulation
technique to find the most potent bioactive compound for the
treatment of monkeypox infection. As mentioned earlier, the
Catharanthus roseus has been employed to treat various illnesses in
humans like diabetes mellitus, cancer, hypertension, and this plant
also exhibits anti-inflammatory, antithrombotic, antioxidant, anti-
allergic, and vasodilatory effects, and cardio-protective properties.
Having various health benefits, Catharanthus roseus was selected in
this study for its rich phytochemical profile and its potential to yield
bioactive compounds capable of targeting the A42R protein that
found in monkeypox virus. Through molecular docking simulation,
we can predict various bonds contributing to stabilizing the
interactions. Lower docking scores show more favourable binding
interactions, reflecting stronger affinity and greater stability of the
ligand—protein complex. Brassinolide, a phytochemical found in
Catharanthus roseus and various other plants, also shows the highest
binding score with the targeted protein A42R among all other
compounds used in this study, i.e., -8.7kcal/mol and binding
interaction energy E=718.52, which suggests that brassinolide can
be a potential inhibitor of protein A42R essential for proliferation
and distribution of virus.  Cidofovir, taken as a reference inhibitor
of A42R protein of Human Monkeypox Virus (hMPXV) with
showed -6 Kcal/mol binding affinity. It exhibits several
unfavourable bonds while binding to the target protein, i.e., A42R
protein, showing 5 phytochemicals out of the 7 phytochemicals used
have performed better in comparison to the cidofovir, an already
present treatment option for monkeypox infection in market. The
names of those five phytochemicals are brassinolide, teasterone,

typhasterol, Quercetin, and kaempferol.
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this submission is likely Al generated, scores below the 20% threshold are not about a student’s work. We encourage you to learn more about Turnitin's Al detection
surfaced because they have a higher likelihood of false positives. SPRADRRE Deore Using 118 te0u

Disclaimer

Our Al writing assessment Is designed to help educators identify text that might be prepared by a generative Al tool. Our Al writing assessment may not always be accurate (it may misidentify
writing that Is likely Al g ted as Al g d and Al paraphrased or likely Al gy ted and Al paraph | writing as only Al generated) so it should not be used as the sole basls for

adverse actions against a student. It takes further scrutiny and human judgment in conjunction with an organization's application of its specific academic policies to determine whether any
academic misconduct has occurred,

Frequently Asked Questions

How should I interpret Turnitin's Al writing percentage and false positives?

The percentage shown in the Al writing report is the amount of qualifying text within the submission that Turnitin's Al writing

detection model determines was either likely Al-generated text from a large-language model or likely Al-generated text that was [
likely revised using an Al-paraphrase tool or word spinner.

False positives (incorrectly flagging human-written text as Al-generated) are a possibility in Al models,

Al detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives, To reduce the
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).

The Al writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted
assignment in accordance with their school's policies.

What does 'qualifying text' mean?

Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences d in paragraphs that make up a
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely Al-generated will be
highlighted In cyan in the sub and likely Al-g d and then likely Al-paraphrased will be highlighted purple.

Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the
percentage shown.
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